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Named after Giovanni Battista Piranesi, the foremost 18th century architectural draftsman, Piranesi is an interactive paint system
that enables  you to produce exhibition quality images from three-dimensional models. You can paint the surfaces of a rendered
scene, and the paint is sensitive to the surface you want to paint and to the angle and distance of the surface within the scene.

In the following illustrations, a three-dimensional model of a city is painted in Piranesi to produce a non-photorealistic, atmospheric
effect.
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Piranesi’s intelligent painting tools allow you to produce images which emphasize what is important and relax focus on other areas.
Unnecessary detail does not need to be modelled.
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The secret of Piranesi lies in the EPix (Extended Pixel) file format, in which every pixel stores depth and material information
alongside the colour values supplied by the rendering application. EPix files can be created by many popular CAD and visualisation
packages or using the Vedute renderer supplied free with Piranesi.

Piranesi uses extended pixel data to control the operation of its painting tools and to allow the precise application of textures,
cutouts, and atmospheric effects.

The depth and material values are updated by Piranesi operations so that effects can be applied cumulatively in the development of
the final image.
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This guide describes how to install Piranesi on Apple� Macintosh� computers. It also explores the Piranesi components and details
some of the basic tasks to get you started.

To help you find more information quickly, pointers to related help topics are given throughout the guide.
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Piranesi provides extensive online Help. Details of every command and dialog are included, along with procedures for completing
each task. You will also find a number of example painted scenes to illustrate what you can achieve with Piranesi.

To use the online Help system

1 Hold down the Command key (�) and then press ?, or on the Help menu, click Piranesi Help.

The main Help window is displayed, showing the topic Overview of Piranesi.

2 To choose how you would like to navigate to the required help topic, click Contents, Index, or Search in the left pane.

3 To display help on a topic:

� from the Contents pane, click a plus sign to expand the topics under a heading, then click the topic you require

� from the Index pane, click an alphabetic letter or scroll through the index entries, then click the entry you require

� from the Search pane, type the work or phrase and press Enter
Up to 30 results are returned, in order of relevance. Click the topic you require.

�����
���

Piranesi offers a number of tutorials designed to give you a clear idea as to how Piranesi can be used to paint your images. The
tutorials are an excellent way to learn about the many unique features of Piranesi.

To access the tutorials

� on the Help menu, click Piranesi Tutorial

You can navigate through the tutorials in the same way as the Help system.
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You can find the official Piranesi World Wide Web site at www.informatix.co.uk/piranesi

To access the Web site directly from Piranesi

� on the Help menu, click Piranesi Online
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Before you install Piranesi, ensure that your Apple Macintosh computer has at least:

� 400MHz PowerPC� G4
� Mac OS� X 10.2.6, or later
� 256 MB memory
� 1280 x 1024 or greater screen resolution, with thousands or millions of colours

For QuickTime� panorama generation, a faster processor and more memory are recommended.

To install Piranesi

1 Insert the Piranesi CD into the CD-ROM drive.

2 Open ‘Install Piranesi 3’ on the CD.

The Piranesi Installer is displayed.

3 Follow the instructions on screen and, when prompted for the installation you require, choose from:

� Install

Click Install to install the Piranesi program, Vedute, examples of Piranesi scenes, the libraries, the tutorials, and the help
files.

� Customize

Click Customize to choose which of the components you want to install.

A list of components is displayed together with the disk space requirements for each item selected. You can select and
deselect components by clicking the appropriate checkboxes.
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The first time you start Piranesi, you are prompted for your licence details.

Piranesi allows you a 30 day trial period in which to supply the licence information, after which you will no longer be able to use
Piranesi.

Contact your Piranesi distributor who will provide you with a validation code.
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There are two types of Extended Pixel (EPix) file that you can work with in Piranesi:

� standard EPix files, which have the extension .epx
� panorama EPix files, which have the extension .epp

You can create new EPix files in Piranesi. You can create blank standard or panorama EPix files. You can also create standard EPix
files from existing images, by importing a plan or elevation image as a starting point. You can then paint the EPix files in the usual
way.

For more details, see Creating new EPix files in Piranesi Help.
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To paint a 3D model in Piranesi, you first create the model using a conventional modelling application. Although the model can be
as simple or complex as you wish, you would usually render the model as a simple flat-shaded image. The image should be lit as
required, and viewed from a good eye position.

If you are preparing a panorama scene, you should also set up the view angle, the view direction (set by the eye position and the
look-at point), and the aspect ratio before you render the file. You can look up and down, and around a panorama by panning, tilting,
and zooming the scene.

You must then save the file as an EPix file. If your rendering application cannot save files in EPix format, you can use the Vedute
application supplied with Piranesi to convert the file. Vedute can open a number of different file formats. You can set up the eye
position, look-at point, lighting, and shadows using Vedute. For more information, refer to the Vedute online Help.

Plug-ins which generate EPix files for use within Piranesi are available from the Piranesi World Wide Web site at
www.informatix.co.uk/piranesi. You can also find details of other products that support EPix file formats on our Web site.
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An Extended Pixel (EPix) file stores the following information about every pixel that makes up the scene:

� RGB the colour of the pixel

� Depth the distance from the eye position to the pixel

� Material the material definition of the pixel

The colour information for each pixel enables you to restrict painting to pixels of a particular colour (within a specified tolerance);
the depth information enables you to paint the scene in 3D, and to apply the rendering techniques. The material information means
that you can restrict painting to pixels rendered in particular materials.

EPix files also store information about the view of the model, such as the eye position.
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A Piranesi channel contains information about one particular property of every pixel in an EPix file. There are six channels in all.

The RGB, Depth, and Material channels store the colour, depth, and material information about the current settings in the painted
scene. The RGB channel is changed when you paint. The Depth and Material channels are changed when you add cutouts to a scene,
extend or create a new plane, and when you restore parts of the scene. For example:
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Three more channels, called the Restore channels, store RGB, depth, and material information about the pixels in the rendered file.
Initially, these channels store the RGB, depth, and material of the original EPix file that you first open. However, you can
subsequently ‘re-render’ the scene to change the contents of these channels.

The information in the Restore channels is used to create many effects, or to ‘remove’ the effects you have added since you last
rendered the file. For example, when you use the Restore render action, the information in the current channels is replaced by the
information in the Restore channels.
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This section takes you through some basic Piranesi tasks. It provides an introduction only; for a comprehensive guide refer to
Piranesi Help.

To start Piranesi

You can start Piranesi from the Piranesi 3 folder in your Applications folder.

Or:
� open an EPix file by double-clicking the filename

� or drag an EPix file onto the Piranesi application

You can use raster files in Piranesi, to create brushes, cutouts, textures, and grains. By default, if you were using raster files when
you last exited Piranesi, the raster files are loaded during startup so that they are immediately available.

You can use your preferences to ensure that Piranesi does not load the raster files in the future. For details, see Setting preferences on
page 11.
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By default, when you first use Piranesi, the following components are displayed:

� menu bar

� Toolbox

� Tools Manager

� Style Browser

You can display and hide the Toolbox, Tools Manager, and Style Browser using the Window menu.

Piranesi provides Help Tags so that you can see descriptions of items when the mouse pointer pauses on an element. You can
sometimes see more detailed descriptions by pressing � when you point at an item. For example:
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Whenever there is a short delay during an operation, Piranesi displays a Status window. This keeps you informed of the progress of
the operation, and enables you to cancel it if required. For example:

'�
�����

At the top of the screen is the Piranesi menu bar. Not all menus are available until you open or create a file.

A number of contextual menus are also available with Piranesi. The commands on a contextual menu apply specifically to the area
of Piranesi in which you are working.

To display a contextual menu

� hold down Ctrl and click the item

� or use the right mouse button, if available
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The Toolbox provides the tools that you use to paint a scene.
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In Piranesi, the term painting is used to describe the action of applying the result of the Toolbox settings to the scene. Note also that
the term effect is used to describe the result of all the Toolbox settings.

To see the name of a Toolbox item, point to it with the mouse. To see a more detailed description, press � and point to the item.

You can select the different tools on the Toolbox in any order, although it is often convenient to work from top to bottom. The tools
are summarised below and described in more detail in Painting with Piranesi on page 20.

Use familiar painting tools such as brush, pen, and ‘fill can’, enhanced to respond to depth and material
information stored in the scene.

Navigate the scene using the Pan and Zoom tools.

Place raster images or text, scaled and clipped to their location in the scene. Choose to place the cutout
normal to the scene or aligned to a selected plane.

Limit the scope of the current applicator to the plane, orientation, material, or colour selected at the start of
the stroke, or specify materials to paint.

Choose whether the selected tool will paint using the current effect, restore the initial image, highlight
edges, construct planes, or apply filters.

Select a standard or custom colour, or sample one from the scene, then choose the proportion in which the
selected colour will be blended with the Restore colour.
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Apply photographic, hand-drawn, or procedural textures, and choose the proportion in which the texture
colour is blended with the selected colour. Control masking of the scene by applying a texture with a
stored transparency map.

Apply a masking texture in the plane of the scene to simulate paper effects.

Define the overall intensity of the current effect and choose from one of 18 Blend types, including opaque
paint, translucent ink or tint, to determine how the effect is to be applied.

Use Linear, Radial, or Illumination fade to add atmospheric effects to your scene. Create realistic fogs,
lighting, or distance fades, or use your imagination to devise unique special effects.

Change the window display. Choose from: standard screen, full screen with menu, or full screen without
menu.

To cycle through the window display modes, press F.
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The Tools Manager provides access to features and tools that you will often use in Piranesi.

To display the Tools Manager

� if the Tools Manager is not currently displayed, on the Window menu, click Show Tools Manager

The Tools Manager contains three palettes which, when collapsed, are shown as:

Each title bar is the access point to a corresponding palette of tools and features.

� to expand an entry, click the required palette’s title bar

When you expand an entry, the adjacent arrow changes to a down-pointing arrow ( ) and the corresponding palette unfolds.
Clicking the palette title a second time folds the palette up.

A summary of the contents of each palette is given in the following sections; details on specific items are given in the relevant
sections in this guide.

If you close the Tools Manager, you can redisplay it using the Window menu, or you can double-click a button on the Toolbox to
show its settings tab.
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The Information palette contains four tabs:

To display a tab on the Information palette, click the tab name.
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� Pixel tab
When you have opened a file, the Pixel tab displays information about the pixel that lies directly beneath the mouse pointer.

As you move the pointer over the scene, the pixel information is updated. By default, the following information is displayed:

— the X, Y coordinates of the position in pixels (where 0/0 is the top left-hand corner of the EPix file), and the distance of the
pixel from the eye position in the rendered image (the depth, D) in the current units

You can display the X, Y, and Z coordinates of the rendered scene in world coordinates by choosing XYZ Position from the
drop-down list.

— the RGB (red, green, blue) values

You can display the HSV (hue, saturation, value) or HLS (hue, lightness, saturation) values by choosing the required scheme
from the drop-down list.

— the name of the material in which the pixel was rendered

You can also view the name of the material beneath the mouse pointer on the status bar, which is at the bottom of the EPix
window.

You can use the Material tab (see below) to change the name of a material, and to merge materials.

The information displayed is for the type of channel shown in the document window. For example, if you are viewing the
Current Material channel, all the information relates to the Current channels; similarly, if you are viewing the Restore RGB
channel, all the information relates to the Restore channels.

Details about how to view different channels is given on page 12.

� Navigate tab
The Navigate tab shows a thumbnail of the current scene, which you can use to specify the extent of the view, and to pan and
zoom the view.

See page 14 for more details about navigating a scene.



Introducing Piranesi 3.1

9

� Colour tab
The current paint colour is displayed on the Toolbox, in the Colour preview box.

You can select a new paint colour using the Colour tab, which is automatically made current when you click on the Colour
preview box on the Toolbox.

For details about how to select a paint colour, see page 28.

� Material tab
The Material tab shows the materials used in the current file.

You can use the Material tab to edit the names and colours of materials, or to merge materials. The material name is shown on
the Pixel tab when you move your mouse over a pixel that uses that material. The material colour is used when you are viewing
a material channel.

You can add a new material to an EPix file by creating a new plane or by adding a cutout to a scene.

For more information about materials, refer to Piranesi Help.
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You can use the Settings palette to set properties for the tools on the Toolbox.

A tab is available on the Settings palette only when its corresponding tool is active. For example, if you clear all locks on the
Toolbox, the Lock tab is not displayed. The tabs are displayed in the order in which the tools appear on the Toolbox. If there are
more tabs than will fit across the Settings palette, the right-hand tab shows an arrow which, when you click, displays a contextual
menu showing the available tabs to pick from:

Double-clicking a button on the Toolbox also selects the corresponding tab on the Settings palette.

You can reset the options on the current tab to their default values by clicking the Reset button.
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The Cutout Manager is for managing floating cutouts. A cutout is a piece of stage scenery, such as a tree or person. When you
initially place a cutout, it is floating. This enables you to make changes to the cutout using the Cutout Manager, such as tweaking its
size or changing its shadow colour.
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You can select one or more floating cutouts to work with. For example, you can make the selected cutouts invisible or delete them
from the scene.

You also use the Cutout Manager to set up shadow direction and softness. When you have set up the shadow properties, you can
update some or all of the floating cutouts with the new values. Note that the shadow colour and blend mode are applied to all
floating cutouts immediately you change it.

Floating cutouts are saved when you save the EPix file. However, once you have placed a number of cutouts, you may want to save
them to a cutouts file. If you subsequently update the model in your renderer, you can then load the cutouts into the new EPix file,
rather than placing them again.

You cannot paint over floating cutouts. However, when you have finished working with the cutouts, you can burn them into the
scene. The cutouts are then removed from the list in the Cutout Manager, and cannot be tweaked or changed. Cutouts that have been
burnt in are an integral part of the scene just like any other item of geometry, and can then be painted. Note that burning in cutouts
will also speed up the loading of the file when you next reopen it.

Full details of how to work with floating cutouts are provided in Piranesi Help.
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The Style Browser is one of the key windows that you will use in Piranesi. You use the Style Browser to select stored paint styles
when you paint the scene.

To display the Style Browser

� on the Window menu, click Show Style Browser

The Style Browser is described in more detail on page 15.
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You can customize Piranesi by setting up a number of preferences.

To set your preferences

� on the Piranesi menu, click Preferences…
You can use the Preferences dialog to set up general user preferences, such as setting the display units to use, and the size of the
undo buffer list.

For details about changing your preferences, see Setting preferences in Piranesi Help.
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To open a file

� press �–O, or on the File menu, click Open…
� or open an EPix file by double-clicking its filename
� or drag an EPix file onto the Piranesi application

The file is opened in a new document window in Piranesi. The name of the file is shown on the title bar of the window. You can see
the location of the EPix file by pressing � and clicking on the icon adjacent to the filename on the title bar.

If any floating cutouts have previously been saved with the file, they are loaded into the scene. You can press the Escape key to
interrupt this. Note that if Piranesi cannot find a raster file for a cutout, for example because it has been moved to a different
location, a warning is displayed for each missing raster file. To include a missing cutout in the scene, locate the missing raster file
and reapply the cutout. For more details, see Raster files and cutouts in Piranesi Help.

Each document window has a status bar at the bottom of the window that displays feedback information about the operation in
progress, the current channel name and current zoom factor. You can also show and hide the name of the material currently under the
mouse pointer, using the drop-down menu to the left of the channel name (shown overleaf, in Viewing channels).

When you have opened a file, its name is added to the recent file list. You can open the file again without using the Open dialog, by
clicking Open Recent on the File menu and then clicking on the filename in the submenu. The files are displayed in the order in
which they were opened, with the most recent file at the top. You can clear the recent file list at any time by clicking Clear Menu at
the bottom of the list.

You can also import images in various file formats into the active EPix file, including Picture files for Macintosh, Windows bitmap
files, and Portable Network Graphics (PNG) files. You might do this, for example, if you have generated the EPix file without
shadows and you want to overlay an RGB file that has shadows.

For more details, see Importing a file in Piranesi Help.
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When you paint, you usually view the information held in the RGB channel. This is the default when you start Piranesi. However,
you may want to check the other channels from time to time. For example, if you are going to use the Material lock, you may want
to check which items in the scene use a particular material.

The name of the current channel is shown to the right of the status bar on the document window. For example:
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To view a different channel

� on the View menu, click the appropriate channel name

� or click the channel pop-up menu on the status bar, and select the appropriate channel

You can also use the Pixel tab to display the properties of a particular pixel in the EPix file.
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You can display and edit a number of file properties using the File Properties dialog:

� on the File menu, click Properties…
Image information about the current file is shown in the top section of the dialog. Artist and copyright details may be displayed if
they have been specified. You can edit these details, add a description of the image, and change the resolution to be used when you
export the scene. The extent of the image in pixels, and its in-memory size, are also shown.

You can define how the model units in the file correspond to the ‘real world units’ by typing in the ‘1 model unit is’ box or by
converting an on-screen measurement. You use the Set Model Size command on the Edit menu to calculate the model units using an
on-screen distance.

The bottom of the dialog shows file information.

For more details, see Viewing and changing file properties in Piranesi Help.
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You can create new EPix files (both standard files and panorama files) from within Piranesi. You can then paint the new EPix files
using all the usual Piranesi tools.

To create a new EPix file

� press �–N, or on the File menu, click New…
Piranesi displays the New File Assistant.

You can either create a blank EPix file, or you can specify an existing 2D image to use. You can then choose to create a plan view or
an elevation view, and you can specify the size and depth of the scene.

When you create a new EPix file, the file does not contain any geometry. Consequently, no material information is initially available.
You can create material and depth information by constructing new planes and restoring channels.

When you create a new EPix file from an image file, you should set up the model units so that when you use cutouts, textures,
brushes, and so on, they are the correct size in the scene.

For details about how to set up the model units, refer to Units in Piranesi in Piranesi Help.
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You may want to use more than one window on the same scene. For example, you may want to see an enlarged or reduced view of
the scene, or show another part of it, or you may want to view two different channels at the same time.

To open a new window on a scene

1 Click the title bar of the window that contains the scene, to make it the active window.

2 On the Window menu, click New Window.

The new window is created. The RGB channel of the scene is shown at the maximum size to fit in the Piranesi window. You can
have as many windows on a single scene as you like.
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You can have a number of files open at one time. Each file is displayed in a new window when you open it.
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The open windows are listed at the bottom of the Window menu. To bring a window to the front and make it active, click its name in
the list. Alternatively, you can make a window active by clicking on its border.

If available, you can also use the following Command-key equivalents:

� to activate the next open window, press �–~
� to activate the previous open window, press �–�–~
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When you have a number of windows open:

� to minimize the active window, on the Window menu, click Minimize Window

� to bring all open Piranesi windows forward, on the Window menu, click Bring All to Front
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To close a document window:

� on the File menu, click Close

� or click the red button in the top-left corner of the window:
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When you are painting a scene, you may want to enlarge the image on your screen to paint details, or reduce the size of the image to
get an overall impression. Note that when you are zooming, the actual size of the scene is not changed, it is only the appearance of
the scene on the screen.

You can zoom in to any scene to a maximum of 16:1. You can also zoom out to a maximum of 1:16 in a standard EPix file. In a
panorama EPix file, you can zoom out to 1:1 or 120� depending on the size of the document window.
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To zoom in or out of the centre of the scene

� press �–+ (plus key) to zoom in; press �–– (minus key) to zoom out

� or, on your numeric keypad, press + to zoom in, or press – to zoom out

� or use the zoom commands on the Zoom menu

� or press Ctrl and click in the scene, and use the zoom commands on the contextual menu

The scene is zoomed to the next zoom factor. For example, a scene displayed at 2:1 would be displayed at 1:1 after the first zoom
out, then 1:2, 1:3 and so on.
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You can use the Zoom tool to zoom in and out centred on the position at which you click on the scene. When you zoom in, the size
of the scene in the view is doubled; when you zoom out, the size is halved.

To use the Zoom tool

1 On the Toolbox, click the Zoom button 

The pointer changes to

2 To zoom in, click on the position at which you want to zoom; to zoom out, press  the Option key ( ) and click on the scene.

The scene is zoomed by a factor of 2. For example, a scene displayed at 4:1 would be displayed at 2:1 after the first zoom out, then
1:1, 1:2, 1:4 and so on.

If you are using a wheel mouse, you can rotate the wheel in the required direction to zoom centred on the current position of the
mouse pointer.

Note that you can return the scene to its original pixel resolution, that is, at 1:1 by double-clicking the Zoom tool.
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You can zoom by specifying the rectangular extent of the view that you require. Note that Piranesi zooms to the nearest integer
zoom factor. If either dimension of the rectangle is more than half the overall image size, the entire scene is displayed.

To use the Zoom tool to specify the extent

1 On the Toolbox, click 

2 In the document window, drag from one corner of the required extent on the image to the opposite corner of the required extent.

To use the Navigate tab to specify the extent

1 On the Tools Manager, click the Information palette title bar.

2 On the Information palette, click the Navigate tab.

The Navigate tab shows an image of the view in the active window.

3 Press Ctrl and drag from one corner of the required extent on the image to the opposite corner of the required extent.

As you move your pointer, a rectangle is drawn to indicate the extent. The rectangle remains on the image to indicate the current
extent. You can drag the rectangle to move the position of the visible extent—see Panning below.
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If you have zoomed in to a scene, you may want to shift the centre of the view. You can do this by:

� using the Pan tool to drag the scene within its window

� or using the Navigate tab (on the Information palette of the Tools Manager)

� or using the scroll bars

� or, if you are using a wheel mouse, pressing the wheel and dragging the scene

� or holding down the Spacebar and using the mouse to drag the scene

To use the Pan tool

1 On the Toolbox, click 

The pointer changes to

2 Drag the scene to the position you require.

To pan using the Navigate tab

1 On the Tools Manager, click the Information palette then click the Navigate tab.

The Navigate tab shows an image of the current scene. The rectangle on the image indicates the extent of the view.

2 Click at the new view centre; or press the mouse button with the pointer over the rectangle, and drag the rectangle to move the
position of the view extent as required.
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Each time you zoom or pan, Piranesi saves the view in memory. You can switch back to the previous view:

� on the View menu, click Previous

You can continue to switch back to previous views in reverse order by choosing Previous repeatedly. Piranesi saves up to 100 views.

When you have switched back to a previous view, to switch forward to the next view:

� on the View menu, click Next

&�(���

The simplest and quickest way to paint with Piranesi is to select an existing style from the supplied library of styles, or from a
library of styles that you have created yourself. The style defines a collection of settings on the Toolbox. When you apply the style,
the Toolbox is updated with the settings.

If the library style does not contain the exact settings and details that you require for a particular effect, you can apply the style
nearest to the one you require, and adjust the Toolbox settings as necessary.

You can practise creating and applying styles by using the Piranesi Tutorials.

����&�(���)������

You select and manage styles using the Style Browser.
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The above illustration shows the default layout of the Style Browser. You can customize the appearance of the Style Browser using
the buttons at the top right of the list view. You can change the display to icons or details, and choose which columns are shown for
styles.

The Style Browser provides a toolbar that gives you quick access to menu commands and features. By default the toolbar is not
displayed. To show and hide the toolbar, click the button in the top-right corner of the Style Browser: 

Piranesi supplies a default set of buttons for the toolbar. You can choose which items appear in the toolbar, and in what order. You
can also change the display of the toolbar buttons to icons and text, icons only, or text only.

For details about customizing the Style Browser, see Changing the view in the Style Browser and The Style Browser toolbar in
Piranesi Help.
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Styles are organized into libraries and categories. Each library contains at least one category.

You use the libraries and categories to organize styles so that you can locate them easily. For example, you might have a library
called Textures to hold all the texture styles. The categories within the Textures library could then group the styles into types of
texture, such as Stone, Brick, Vegetation, and so on. You can also group styles into subcategories. For example, a library called
Cutouts could have People as a top level category, with Men and Women subcategories nested below.

Another use of categories could be to group styles that you often use in a particular procedure. For example, you may want to create
a number of scenes that have similar effects. You can number the styles so that they are listed within the category in the order in
which you usually use them. Then when you use the styles, you simply work down through the list.

To expand a library in the tree view, click the right-pointing arrow ( ) to the left of the name, or double-click the library. A list of
the categories within the library is displayed. To display the styles stored in a category, click the category. The styles are shown in
the list view of the Style Browser.

To collapse a library, click on the down-pointing arrow ( )
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The supplied Piranesi libraries contain a wide selection of predefined styles. Any style libraries that have been installed with Piranesi
are automatically opened in the Style Browser. You can open existing libraries and create new libraries in which to save your styles.
You can also change the properties of a library, for example to rename it, and create and delete categories.

For full details about working with style libraries, refer to Piranesi Help.
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More than one user can open a library at one time. To ensure that a number of users do not edit the library at the same time, and the
styles are shared correctly, you can lock the library.

To share a library

1 Select the library.

2 On the Style menu, click Library, Properties…
The Style Library Properties dialog is displayed.

3 Select the Shared checkbox.

While a library is shared, you cannot amend any of the library or category details, or the styles within the categories.
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You can set up partial styles that do not apply settings to all of the Toolbox options. For example, a partial style may define only the
brush to be used, and none of the other settings, or it could define a texture/colour combination that you frequently use.

Partial styles mean that you can build up libraries of standard applicators, textures, and grains. You can then browse the libraries at a
later date, using the thumbnail images in the Style Browser to assist you with your selection.

You are recommended to create at least the following libraries of partial styles:

� Brushes

� Cutouts

� Textures

� Grains

When you have set up the partial styles, you can build up the effect you require by applying a series of partial styles from the Style
Browser. For example, you might apply a brush style, then a texture style, and finally adjust the remaining Toolbox settings
manually.
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1 Select the library and category in which the style is stored.

The styles in the selected category are displayed in the list view of the Style Browser.

2 Select the style that you want to apply.

3 On the Style menu, click Apply.

Or in the list view, double-click the style.

The style’s settings are applied to the Toolbox.
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1 Change the settings of the Toolbox to create the effect you require.

2 On the Style menu, click New…
Or on the contextual menu in the list view, click New Style…

3 In the Name box, type a name for the style.

Styles are displayed in the list in dictionary order. Therefore, if you want the styles to be displayed in a particular order, pay
special attention to their names. For example, you could begin each style with a number (01 Clear to white, 02 Edge brush, and
so on).

4 In the Description box, type a description for the style.

5 From the Library and Category lists, select the location in which you want to save the style.

Only libraries into which you can save styles are listed.
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6 If you want to specify a partial style, so that not all Toolbox settings are changed when you select the style, select the elements
of the style that you want to apply from the Fields list.

The elements of the style that are currently active are selected. Select and clear the appropriate checkboxes, as required.

7 Click OK.

The style is added to the selected category in the Style Browser.
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You may want to change the settings of an existing style. For example, you might change the colour used, but keep the other
Toolbox options the same.

To edit a style

1 Apply the original style.

2 Amend the settings on the Toolbox, as required.

3 Add the style as a new style.

The details in the New Style dialog default to those of the selected style (highlighted in the Style Browser). If the selected library
is locked, the Library and Category default to the first unlocked library and category.

4 If the style is a partial style, select the parts of the style that you want to save from the Fields list.

5 Click OK.

Piranesi displays a prompt for you to confirm that you want to overwrite the existing style. Click OK to overwrite the style. If
you click Cancel, you are returned to the New Style dialog so that you can enter a different name for the style.

For full details about copying, moving, and deleting styles, refer to Piranesi Help.
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Some styles use raster image files. For example, some brushes, textures, and grains use raster files. When you apply a style that
references a raster file, Piranesi must access the file.

You specify the location of the raster file when you create the style. For example, when you create a brush that uses a raster file, you
point Piranesi to the location of the file. Then, when you save the style, Piranesi remembers where the raster file is stored and reads
the file each time the style is used.

It is good practice to store related raster files together, in the same folder. For example, you might store all the raster files used for
brushes in a folder called ‘Brushes’.

If the raster files are stored in the same folder as the style library file, or in a folder below, the folder containing the library file can
later be moved without affecting use of styles in Piranesi. If, however, you rename or move a raster file, you will need to apply the
style, browse for the new filename on the Settings palette, and resave the style. If you do apply a style that uses a raster file which
Piranesi cannot locate, its filename is shown with a ‘no file’ icon on the Settings palette. For example:

You can display the original location of the missing file by clicking on the raster filename on the Settings palette. For example:

If you choose a folder or disk from the menu, the location opens in Mac Finder.
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When you are painting a scene, you can undo your last paint action:

� press �–Z, or on the Edit menu, click Undo

This command is useful if you make a mistake. It also means that you can test an effect, then undo the test before you apply it in
earnest.

You can continue to undo actions in reverse order by repeatedly choosing Undo.

Piranesi stores your actions in a memory buffer. You can set the size of the buffer in your preferences.
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You can redo an action immediately after you have undone it:

� press  �–�–Z, or on the Edit menu, click Redo

You can continue to redo actions that have been undone consecutively by repeatedly choosing Redo. Note, however, that you cannot
use Redo if you have painted the scene since the last Undo.
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A particularly useful feature in Piranesi is Reapply. Often, you may want to try out an effect that you have created, adjust the effect,
then reapply it to the scene in exactly the same way.
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To reapply an effect

� press �–R, or on the Edit menu, click Reapply
The previous action is undone, then redone with the new effect.
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If you have started a painting action that takes a few moments to complete, such as filling the scene with paint, or even opening a
file, you can stop the action by pressing Esc.

If the action has made a visible change to the scene, you can use Undo to reverse the change.
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When you have painted a scene, you can print it. You can first preview the scene to see how it will look when it is printed.

To print the scene

1 Press �–P, or on the File menu, click Print…

2 If necessary, select the printer and layout options you require.

3 If you first want to preview the scene, click Preview on the dialog.

The scene is shown in relation to the paper size.

4 Click the Print button.
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As you work you can save your file to the same name:

� press �–S, or on the File menu, click Save

If any floating cutouts have been placed in the scene, they are saved as part of the EPix file.

If you have several files open, you can save all changes to all files by holding down  and then pressing �–S.

You can save your work to a file with a different name or to a different location, by clicking Save As on the File menu. Note that you
cannot save an EPix file of one format to the other EPix format.

By default, EPix files are compressed using LZW compression when they are saved. You can specify that a file is not to be
compressed using the file’s properties.

You can also export EPix files to various file formats, such as Picture files for Macintosh, Windows bitmap files, and Portable
Network Graphics files.

For details about how to export files to different formats, see Exporting a file in Piranesi Help.
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When you have finished working on a scene, to close the file:

� press �–W, or on the File menu, click Close
All views onto the file are closed.

� or if the scene is displayed in only one document window, click at the top left of the window

If you have made any changes to a file but not saved them, you are prompted to save the changes before Piranesi closes the file.
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To quit from Piranesi

� press �–Q, or on the Piranesi menu, click Quit Piranesi

If you have any files open that have unsaved changes, you are prompted to save these changes before Piranesi closes.
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The Piranesi painting facilities are extremely powerful and versatile, enabling you to create a great variety of painting effects. The
tools provide many options which allow you to ‘test’ the effect, and refine your image instantaneously.

This section provides an overview of the Piranesi tools and features that you can use to create high-quality images. For full details
about setting up and using the different actions and features that Piranesi offers, refer to Help.
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When you paint a scene in Piranesi, you use the Toolbox to specify settings such as brush type, colour, texture, render action, and so
on. You then use the chosen applicator to apply the result to the scene. The way in which you apply the effect to the scene depends
upon the applicator you have selected.

Piranesi offers the following applicators:

Brush uses your mouse pointer as a paintbrush

Pen draws straight lines on the scene

Local fill applies the effect to a single area of the scene

Global fill applies the effect to multiple areas of the scene

Multiple fill applies a number of fill styles consecutively to the scene

Montage pastes a cutout into the scene

Painter splatters paint over the scene to create special effects

You define the characteristics of the applicator using the tabs on the Settings palette of the Tools Manager.

To display the appropriate tab on the Settings palette

� double-click the applicator’s button on the Toolbox

If the Tools Manager was not already open, Piranesi opens it, expands the Settings palette and selects the the appropriate tab.

If the Tools Manager is already displayed, you can also select the tab for a tool that is used by the current style by clicking it on the
Settings palette. (The Local and Global fill applicators do not have a tab on the Settings palette.)
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The Brush applicator enables you to paint freehand, as if your mouse pointer is a paintbrush.

There are four types of brush:


��
�� ��

����� ��	
�� ���
����

For each type, you can use the standard 2D brush, or its 3D equivalent. With 2D brushes, the brush is always facing forwards. With
3D brushes, the orientation of the brush is defined by the plane of the pixel over which the pointer lies when you start painting. 3D
brushes also change size with perspective. For example:
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When you paint a panorama EPix file with a 2D brush, the brush follows the shape of the panorama as though you are painting on
the inside of a sphere centred at the eye point; the brush size is a fixed, specified number of pixels. 3D brushes work in the usual
way.
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Brushes work by applying more paint to the dark areas, and less to the light areas. So, for example, a soft circular brush applies more
paint at the centre of the brush than the outside.

When you paint with a raster brush, again the amount of paint applied depends on how dark the raster image is; white areas are
transparent. If the raster image has colour information, Piranesi automatically interprets the lightness and darkness of the colour
image to produce the brush.

You can use any type of raster file that can be imported into Piranesi as a raster brush. You can also create new raster brushes. For
details, see Importing a file and Creating new raster brushes in Piranesi Help.

You select the type of brush from the Brush tab on the Settings palette, and then define the characteristics of the brush. For example,
you can specify the size and softness of the brush, and change the brush shape by altering its aspect ratio.

You then select the other options on the Toolbox, such as the colour of the brush, as required.

To paint with the brush

� to create a brush-shaped blob of paint, click on the scene

� or drag the brush over the scene to apply paint
You can constrain the brush to a specified direction by pressing Shift when you drag the mouse. The direction in which strokes
are painted is specified on the Brush tab of the Settings palette.

You can stop the brush from painting as you move the pointer by pressing �. When you release �, the brush stroke continues
from the pointer position.

Examples of using brushes are given in Brushes, textures, and grain: how they work in Piranesi Help.

For details of the brush characteristics, see Changing the Brush settings in Piranesi Help.
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The Pen applicator enables you to draw straight lines on a scene. This applicator is particularly useful for re-touching work if you
create a new EPix file from a linework image file.

You can use anti-aliasing to remove the jagged appearance that may be visible with straight lines and edges.

For example:
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You select characteristics for the pen using the Pen tab on the Settings palette. You then select the other options on the Toolbox, such
as the colour for the lines, as required.

To draw a line with the pen

� drag the pen across the scene
You can constrain the pen to a specified direction by pressing Shift when you drag the mouse. The direction in which lines are
drawn is specified on the Pen tab of the Settings palette.

For details of the pen characteristics, see Changing the Pen settings in Piranesi Help.
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The fill applicators enable you to cover entire areas with the effect with one click of the mouse. You may want to do this, for
example, to blank the scene by filling it with white paint, and then use the Restore render action to show portions of the scene.
Render actions are described on page 26.

The first example below shows the original scene. This was then filled with white before using the Edge render action to pick out
places in the scene at which the colour changed significantly:

Often, you will want to fill specific areas on the scene, and you achieve this by using locks in conjunction with the fill applicators.
Global fill fills all similar pixels across the scene; Local fill fills only those pixels that are in the same contiguous area as the pixel
you clicked on. See page 24 for details of how to use the locks with the fill applicators.

A third type of fill, called Multiple fill, enables you to apply a number of fill styles one after the other using a single click on the
scene.

You set up the multiple fill styles in a style category, listed in the order in which you want them to be applied. When you click on the
scene, if any of the styles have locks specified, the point at which you click defines the reference pixel for the lock. Note that with a
Material lock, you can also specify a list of the materials to paint.

To fill with paint

� click on the scene
Ensure that the ‘hotspot’ of the pointer is placed over the item that you want to fill:
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For more details, see Using the fill applicators in Piranesi Help.
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You can add cutouts to the scene using the Montage applicator. A cutout is an item of scenery that you can add to your scene to
increase realism. For example, you could add trees or people to a park scene, or place furniture in an interior room to determine its
best positioning.

You can add an external Image (a raster cutout), or text to your scene.

You can use any type of raster file that can be imported into Piranesi as a raster cutout. You can also create new raster cutouts.

The depths of the pixels that the cutout replaces are changed to reflect the depth at which the cutout was positioned. Piranesi
allocates a new material for each cutout, in the sequence : ‘Montage 1’, ‘Montage 2’, and so on. You can change this name using the
Material tab on the Information palette.

The simplest way to add a cutout to a scene is to select an existing style with the cutout you require, from the Style Browser.
However, you can also set up your own Montage styles.

The way in which you place a cutout depends upon the way in which the cutout is to be oriented (Frontal or Tangent):

� Frontal places the cutout facing forwards (towards the eye position), preserving perspective and scaling

� Tangent places the cutout tangential to a plane selected in the scene
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For example:
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Piranesi also offers more advanced techniques for placing cutouts. For example, you may want to place the cutout with its hook
point on the ground, but the actual position on the ground is hidden by an item in front of this point. For more details, see Placing
cutouts in Piranesi Help.

When you have placed a cutout on the scene, you can use the Cutout Manager to make adjustments to the cutout, such as move or
tweak it.

To tweak a floating cutout

1 In the Cutout Manager, click on the floating cutout.

2 On the toolbar, click 

3 Move the mouse pointer into the scene.

The ‘tweak tools’ are added to the cutout. As you move the mouse around the scene, the pointer changes to indicate the tweak
that you can perform.

For example:

For full details about each tweak tool, see Tweaking a floating cutout in Piranesi Help.

4 Move the pointer over the cutout until you see the required pointer.

5 Drag to move, resize, or rotate the cutout as required.

The cutout is redrawn in the scene. You can undo all tweaks that affect the size, shape, position, and orientation of a cutout.

6 Cancel tweak mode by clicking again or by pressing Esc.
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You use the Painter applicator to scatter paint over the scene, to create special effects.

Piranesi offers three types of painter:
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For each type, you can specify the orientation of the brush marks. You can choose a 2D brush where the brush is always facing
forwards, or a 3D brush where the brush will be oriented in a plane that is orthogonal to the plane of the scene under the brush and a
specified reference plane.
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You can use any type of raster file that can be imported into Piranesi as a raster painter brush. You can also create new raster
brushes.

When you paint the scene, Piranesi scatters brush marks around your mouse pointer. The scattered brush marks are constrained to a
circular area. You define the spread of the scattered marks on the Painter tab of the Settings palette by specifying the radius of the
circular area in pixels. For example:
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Each of the brush marks is a single colour. If you are restoring colour with the Painter applicator, the colour of each brush mark is
defined by the Restore colour of the pixel under the start of the brush mark. This means that if a brush mark overlaps a border
between two colours on the scene, the paint is ‘smeared’ across the border. See Using the Restore action on page 27 for more
information about restoring colour.

For details of the painter characteristics, see Changing the Painter settings in Piranesi Help.

When you have defined the brush that you want, you can paint the scene in the usual way.

To paint the scene

� click on the scene to create one splatter
� or drag the brush over the scene to apply paint

You can stop the brush from painting as you move the pointer by pressing �. When you release �, the brush stroke is continued
from the pointer position.

�%�
����	�
�%
	���
����
�	�
��&

You can also splatter the paint automatically. Piranesi splatters the paint to a grid for which you specify the cell size. If the cell size
is smaller than the brush, the brush marks will overlap, and the scene will become completely splattered in paint. If the cell is larger
than the brush, there will be gaps where the scene has not been splattered.

You use the Splatter button on the Painter tab of the Settings palette to define the splatter grid and to splatter the paint.
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When you paint a scene, often you will want to restrict the items that you paint. For example, you may want to apply a texture to all
items that have been rendered in a particular material.

In Piranesi, you can restrict the paint area by selecting locks from the Toolbox:

restricts painting to pixels in a particular plane

restricts painting to pixels in a particular orientation

restricts painting to pixels rendered in a particular material

restricts painting to pixels of a specified colour

When you select the Plane, Orientation, or Colour lock, you can set a tolerance to specify how strictly the lock is to be applied. For
example, you may want to apply the Plane lock less strictly if the plane is slightly ‘bumpy’, or you may want to use the Colour lock
to paint items that are pure red, and also those that are predominantly red.

When you select the Material lock, you can restrict painting to pixels in different materials by settings up a material list. When a

material list is in use, the Lock button on the Toolbox shows: 

To set a lock

� click on the appropriate button on the Toolbox

When you begin to paint the scene, the lock is defined by the EPix file pixel that is directly under the pointer when you first press
the mouse button. For example, if you have the Material lock set and the pixel you initially click on has the material ‘Roof’
allocated, only ‘Roof’ pixels will be painted.
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You can select any combination of locks. If you select more than one lock, the pixels must fulfil the conditions for all the selected
locks. For example, if the Plane and Material locks are both selected, only pixels of the same plane and material as the initial pixel
are painted.

You may want to use the Orientation lock in conjunction with the Plane lock to prevent ‘leakage’ when you paint a plane.

To clear all locks

� on the Toolbox, click 
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By using locks with the fill applicators, you can specify particular items to be filled with paint. For example, you might choose to fill
all surfaces painted in the colour blue with the colour red.

In addition to using locks to choose what is filled, you can choose to fill all similar pixels across the scene (Global fill), or only those
that are in the same contiguous area as the initial pixel you click on (Local fill).

For example, in the following scene, all the window panes are material ’Glass’ and Material lock is switched on:
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Notice how the shadows are preserved on the glass. This is because we used Overlay blend which mixes the current colour with the
effect, preserving the lightness and darkness of the current colour. If we had used the default Paint blend mode, which paints each
pixel in the effect colour, solid paint would be applied and the shadows would be obscured.

There are 18 blend modes you can select from, to create the desired effects. For more details, see page 32.

Whether you use Local fill or Global fill is not relevant if you are not using locks.

Locks are a powerful facility when used with Multiple fill. They enable you to paint different parts of a scene consecutively, using a
single click on the scene. Each style in the fill sequence can use any combination of locks. If you want each fill action in a Multiple
fill sequence to paint the entire scene, do not set any locks in your fill styles.
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If you do not use locks with the Painter applicator, the different pixel properties are ignored. This means that you may lose some
detail when paint from different planes, materials, orientations, or colours is smeared into one another (although, this may be the
effect that you want to achieve).

In the following example, the original picture was blanked with white paint, then the Painter applicator was used with the Standard
render action and Colour Amount 0% to produce the splattered picture. No locks were set.
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When you have locks selected, if you have ‘Reset lock’ switched off on the Painter tab of the Settings palette, the main brush stroke
is restricted in the usual way. This means that if you drag the brush outside of the area defined by the set locks for the initial brush
mark, the painter does not paint. The locks also restrict the scattered brush marks, although they do slightly overlap the edges of the
lock area to create a soft boundary.
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If you switch ‘Reset lock’ on, the set locks apply to the plane, material, orientation, and colour that are under the individual brush
mark. This means that as you move around the scene, you can apply the paint to the entire scene, but brush marks from different
planes, materials, orientations, or colours are not smeared into one another (apart from the slight overlap).
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The render actions define how the overall effect is applied to the scene. The current render action is displayed on the Toolbox:

The following render actions are available from the list:

� Standard paints without any special effects
� Edge paints only the edges of the items in the scene
� Construct changes the physical structure of the scene by extending an existing plane or by creating a new plane
� Restore applies the Restore RGB, Depth, and Material channels
� Filter applies a filter to the scene
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You use the Edge render action to enhance the edges of the scene in a different colour or texture, or to create outline drawings of the
scene. Piranesi can find edges by looking for places in the scene where the depth or colour changes significantly, or by looking for
changes in the material. You specify the method to be used on the Edge tab of the Settings palette.

If you choose to use depth to define the edges, you can change the balance between Silhouette and Internal edges. Silhouette edges
occur where the depth changes abruptly; Internal edges occur where the surface angle changes, (such as at the corner of a building).

If you choose to use colour to define the edges, you can emphasize areas where significant colour changes occur, or pick out only
the edges with major brightness changes.

In the following example, the scene was filled with white paint, then the edges were picked out using a large, soft purple brush.
Depth was used to define the edges, with an equal balance of Silhouette and Internal:
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For more details, see Using the Edge render action and Changing the Edge settings in Piranesi Help.
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You use the Construct render action to extend an existing plane in the scene or to create a new plane. For example, you may want to
do this to create a new wall that is in the same plane as an existing wall, or add a railing in a new plane.

When you construct a plane, it changes the definitions of the underlying pixels:

� the RGB is painted in the usual way for those pixels that are replaced
� the depth is changed to be the same as the plane you are constructing
� the material is changed to be the same material as the pixel you selected to specify the plane, or you can choose to generate a

new material
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You can define which pixels are replaced using the Construct tab on the Settings palette:

� ‘Replace nearer pixels’ changes the pixels that are in front of the selected plane (like slicing through the scene)

� ‘Replace farther pixels’ changes the pixels that are behind the selected plane (like building a wall)

� ‘Replace all pixels’ changes all pixels

If you are replacing nearer or father pixels, you can choose whether the selected pane is also painted.

In the following example, the Construct render action has been used to build the middle section of wall, using a coloured texture.
‘Replace farther pixels’ was selected, and ‘Include pixels in plane’ was switched off. The existing wall was selected as the plane of
construction. Pixels that lie behind the new plane are hidden by the wall.

For more details, see Using the Construct render action and Changing the Construct settings in Piranesi Help.
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You use the Restore render action to restore the colour, depth, and material of the Restore channels to your scene.

You can restore only part of the scene, for example by using the Restore action with the brush applicator, or you could use a fill
applicator to restore the entire scene.

You can restore only the Restore RGB channel by using the Standard render action and changing the Colour Amount slider on the
Toolbox. For more information, see The Colour Amount slider on page 29.

For more details, see Restoring in Piranesi Help.
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You use the Filter render action to distort the colours in the scene to create a particular effect. For example, you can use filters to
create embossing effects, or to brighten the scene.

The Filter action works by altering the colour of each pixel based on its current RGB and that of its neighbouring pixels. The amount
by which the current colour of the pixel and its neighbours affects the new colour is controlled by the filter matrix.

The filter matrix is a 5x5 grid of numbers. When the filter is applied, for each painted pixel, the RGB values of the pixel are
multiplied by the number at the centre of the grid. Then, the RGB values of the neighbouring pixels are multiplied by the
corresponding numbers in the grid. The results of all the multiplications are added together to produce the new RGB value of the
central pixel. If the final RGB is greater than 255 or less than zero, a value of 255 or 0 is used, respectively.

You can choose to use the restore RGB values instead of the current RGB values, by selecting the ‘Use restore RGB’ box on the
Filter tab of the Settings palette.

You select the filter you require from the list on the Filter tab of the Settings palette. Piranesi offers the following filters:

� Blur smooths edges in the scene
You can specify the range of pixels over which smoothing occurs.

� Emboss creates an embossing effect
You can specify the direction of ‘incident light’ by clicking on the appropriate arrow button.

� Random scatters the colours of painted pixels
You can specify the distance over which scattering will occur (in pixels). You can also specify how scattered the pixels will be,
and the softness of the effect.

� Custom
You can create your own filters, by typing the multipliers directly into the filter matrix.

A number of styles that use customized filters are supplied with Piranesi in the Filters style library.
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� Halftone creates continuous-tone effects
You can choose from a number of predefined halftone patterns.

� Adjust alters the contrast, brightness, saturation, and hue in the scene
You can define the settings manually, or select ‘Best Fit’ to let Piranesi adjust the settings automatically.

Some examples of different filter actions are shown below.
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For more details, see Filtering the effect and Changing the Filter settings in Piranesi Help.
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When you are happy with a set of changes you have made, you may want to re-render the file so that the current RGB, depth, and
material channels are copied into the Restore channels. Then, when you use the Restore action, the re-rendered scene is restored.
Similarly, when the Colour Amount slider is set to less than 100%, (see The Colour Amount slider on page 29), the RGB channel of
the re-rendered scene is used.

Before you re-render the scene, you may want to make a copy of the current file in case you want to return to it later.
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The current paint colour is displayed on the Toolbox, in the Colour preview box:

You can select the colour from the Colour tab, or by picking a colour from the scene using the colour picker.

To select a colour using the Colour tab

1 Click the Colour preview box on the Toolbox.

The Colour tab on the Information palette of the Tools Manager is displayed.

2 Select the colour model to use, by clicking the arrow on the right of the tab and selecting from the pop-up menu.

3 Select the new colour by dragging the sliders to the required values or by typing the values in the boxes.

 The selected colour is shown in the preview box above the sliders.

Alternatively, you can select a saved custom colour, or define a colour by dragging the circle and cross on the colour spectra.

The new colour is displayed on the Toolbox.
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To select a colour using the colour picker

1 On the Toolbox, click 

2 Move the pipette mouse pointer over the scene to the colour you want to use.

3 Select the colour by clicking on the scene.

The new colour is displayed on the Toolbox.

For full details about selecting a paint colour, see Specifying the paint colour in Piranesi Help.
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You use the Colour Amount slider on the Toolbox to define the balance between the colour in the Restore RGB channel and the new
colour:

� 0% uses the Restore colour
� 50% mixes the Restore colour and the new colour equally
� 100% uses only the new colour

For example, if the Restore colour is blue, and the new colour is red:

� 0% produces blue paint
� 50% produces purple paint
� 100% produces red paint

Therefore, when the Colour Amount slider is set to less than 100%, if you paint over sections of the scene that have different Restore
colours, the paint colour changes between different areas in the scene.

Note that if you have already painted the scene and you are applying one colour over another, the Restore colour is the colour in the
Restore RGB channel, not the first colour you painted.

If you want to mix the new colour with a previous painted colour (rather than the Restore colour), use the Blend slider, described on
page 31.

Settings further down the Toolbox, such as coloured textures, may change the final colour of the paint.

To see diagrams of how the effect-colour changes with each tool on the Toolbox, including the colour amount, refer to Diagrams of
colour flow in Piranesi Help.
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The current texture is displayed on the Toolbox, in the Texture preview box:

You turn textures on and off by clicking the Texture checkbox.

There are five types of texture:

� Raster uses an external image file to add realistic effects to a scene
You select the plane in which the raster image will overlay the scene.

There are several modes you can choose from to define the plane. For example, Fit mode maps the raster tile across the full
width and height of the scene, with no perspective, using the set scale; whereas, Auto Tangent places the tile tangential to the
plane, preserving perspective and scaling.

� Noise creates a three dimensional pattern which is the same in all directions
The light and dark areas define how heavily the paint is applied; the darker the area, the more paint is applied.

� Plane creates a three dimensional alpha texture, and has no colour associated with it
The light and dark areas define how heavily the paint is applied; the darker the area, the more paint is applied.

� Captured paints reflections into the scene to create realistic reflections
The reflections are captured from the scene, using a specified plane.

� Cube takes a raster file and makes its aspect ratio 6x1 and wraps it up as a cube
Cube is primarily for painting Piranesi panorama EPix files. Each side of the cube maps onto a corresponding side in the
panorama file.
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You select the type of texture from the Texture tab on the Settings palette. To display the Texture tab, click on the Texture preview
box. You can then define the characteristics of the texture on the Settings palette.

For details of the texture characteristics, see Changing the Texture settings in Piranesi Help.
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When you select a raster image to use as a texture, the raster image you choose may have:

� only ‘alpha’ information
� only colour information
� both alpha and colour information

If a raster texture has only alpha information, an alpha symbol (α) is shown on the Texture preview box on the Toolbox, and the
Texture Amount slider is unavailable. Raster textures with only alpha information work in the same way as brushes; the darker the
raster image, the more paint is applied.

If a raster texture has colour but no alpha information, the α symbol is not shown, and the Texture Amount slider is available. Raster
textures that do not have alpha information are not transparent.

When a raster texture has colour, you can adjust the Texture Amount slider to ‘fade out’ the texture, and simultaneously ‘fade in’ the
paint colour.

If the texture has both colour and alpha information, the texture applies its own colour, but is also transparent and applies paint
where indicated by the alpha information.

When you have applied paint using a raster texture, you can tweak the texture’s size, shape, and orientation. For example, you may
want to line up the texture with existing items in the scene.

Note that you cannot tweak textures out of the current plane, nor can you tweak 2D textures in a panorama EPix file. For more
details, see Tweaking a raster texture in Piranesi Help.
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You use the threshold values on the Texture tab of the Settings palette to define areas of the scene over which solid paint will be
applied, and areas over which no paint will be applied. This is useful, for example, to create etching and half-tone effects.

For more details, see Threshold texture details in Piranesi Help.
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If you select a raster texture that has colour, you can use the Texture Amount slider on the Toolbox to define the balance between the
texture’s colour, and the paint colour. You can also use the Texture Amount slider when you are using the Montage applicator to
paste a cutout into the scene (see Adding cutouts to the scene on page 22).

If you set the Texture Amount slider to 100%, the raster texture’s colour is used. If you set the Texture Amount slider to less than
100% the colour of the texture is mixed with the selected paint colour.

If the Colour Amount slider is set to 50%, and the Texture Amount slider is also set to 50%, Piranesi first mixes the selected colour
with the Restore RGB colour to produce a resultant colour. The resultant colour is then blended with the texture.

Examples of blending colours and textures are given in Mixing colours and textures in Piranesi Help.

To see diagrams of how the effect colour changes with each tool on the Toolbox, including the texture amount, refer to Diagrams of
colour flow in Piranesi Help.
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When you define styles and effects, you can add texture, grain, both, or neither.

Textures are different from grains because they can create a 3D effect and can include colour. The examples below use the same
raster image, first as a raster texture and then as a raster grain.
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You can use a texture to create the same effect as a grain by using an alpha texture in 2D mode. Piranesi offers separate texture and
grain options so that you can overlay grain onto texture.
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The current grain is displayed on the Toolbox, in the Grain preview box:

All grains behave in the same way as brushes, in that when you apply a grain, the light and dark areas define how heavily the paint is
applied; the darker the area, the more paint is applied.

You turn grain on or off by clicking the Grain checkbox.

There are three types of grain:

� Raster uses an external image file to overlay effects on the scene
You can map the raster tile to the scene, pixel by pixel, or across the full width and height of the scene.

� Noise creates a two dimensional pattern.
The light and dark areas define how heavily the paint is applied; the darker the area, the more paint is applied.

� Cube takes a raster file and makes its aspect ratio 6x1 and wraps it up as a cube.
Cube is primarily for painting Piranesi panorama EPix files. Each side of the cube maps onto a corresponding side in the
panorama file.

If you select a raster image with colour information, Piranesi automatically interprets the lightness and darkness of the colour image
to produce the grain.

You can use any type of raster file that can be imported into Piranesi as a raster grain. You can also create new raster grains.

You select the type of grain from the Grain tab on the Settings palette. To display the Grain tab, click on the Grain preview box. You
can then define the characteristics of the grain on the Settings palette.

For details of the grain characteristics, see Changing the Grain settings in Piranesi Help.

To see diagrams of how the effect colour changes with each tool on the Toolbox, including the grain amount, refer to Diagrams of
colour flow in Piranesi Help.

When you have set up a grain, unless you record the settings exactly, it may be difficult to reproduce the grain effect at a later date.
Therefore, when you are happy with a particular grain, it is advisable to save it as a style so that you can select it again, quickly and
easily.
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You use the blend tools to control how the overall effect will be applied to the scene. The blend tools are located towards the bottom
of the Toolbox.
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You use the Blend slider to control how much of the effect is to be blended into the scene.

� 1% is hardly noticeable

� 50% produces a result halfway between the new effect and the existing scene

� 100% completely replaces the original with the new effect
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The first example below shows green paint, using the Standard render action with no texture or grain, applied with different blend
amounts. The second example shows a brick texture applied with different blend amounts.
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To see diagrams of how the effect colour changes with each tool on the Toolbox, including the blend amount, refer to Diagrams of
colour flow in Piranesi Help.
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There are 18 types of blend that you can use, summarized in the following table.

You can see an illustration of each blend type in Selecting the blend type in Piranesi Help.

Blend type Description

Paint applies the effect without changing it further.

Ink produces a translucent effect, so that underlying
colours are partially preserved.

The effect is similar to laying a sheet of celluloid, in
the selected colour, over the scene.

Tint replaces the current colours, but preserves their
lightness and darkness.

You can tint with white to create a greyscale image.

Light mixes the current colour and the effect colour as
though they are light sources (additive colours).

Paint random applies the effect to some pixels, and not to others, in
a random pattern.

Increasing the blend amount increases the probability
that the pixels are painted.

Paint lighter replaces pixels that are darker than the effect colour.

Paint darker replaces pixels that are lighter than the effect colour.

Difference subtracts the current colour from the effect colour,
and takes the absolute (positive) value.

If the effect is white, the current RGB values are
inverted; if the effect is black, the current RGB values
are not changed.

Exclusion produces a result similar to Difference, but of lower
contrast.

If the effect is white, the current RGB values are
inverted; if the effect is black, the current RGB values
are not changed.
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Blend type Description

Hard light produces the effect of shining a harsh spotlight on the
scene.

If the effect colour is lighter than 50% grey, the scene
is lightened (as with the Light blend). If the effect
colour is darker than 50% grey, the scene is darkened
(as with Ink blend). If the effect is white, the scene is
painted white; if it is black, the scene is painted
black.

Overlay mixes the current colour with the effect, preserving
the lightness and darkness of the current colour.

The result is a combination of Ink blend and Light
blend, depending on the effect colour.

Dodge brightens the current colour by an amount that is
dependent upon the effect colour.

If the effect colour is black, the current colour is not
changed.

Burn darkens the current colour by an amount that is
dependent upon the effect colour.

If the effect colour is white, the current colour is not
changed.

Soft light produces the effect of shining a diffuse spotlight on
the scene.

If an RGB component of the effect colour is lighter
than 50%, that colour is lightened in the scene (as
with the Dodge blend). If an RGB component of the
effect colour is darker than 50%, that colour is
darkened in the scene (as with Burn blend).

Hue preserves the lightness and saturation of the current
colour, and changes the hue to that of the effect
colour.

Lightness preserves the hue and saturation of the current colour,
and changes the lightness to that of the effect colour.

Saturation preserves the hue and lightness of the current colour,
and changes the saturation to that of the effect colour.

Colour preserves the lightness of the current colour, and
changes the hue and saturation to that of the effect
colour.

0��

�������!!���

You can use the Fade buttons to create atmospheric effects on your scene. For example, you can use them to create realistic fog in a
scene, or to create special effects with textures and colours.

You can fade the effect linearly between two positions, or radially from a point, or you can simulate parallel or point light
illumination.

You select the type of fade on the Fade tab of the Settings palette.

An illustration of each type of fade is given in Fading the effect in Piranesi Help.
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To fade the effect linearly between two positions, click the Linear fade button on the Toolbox.

Piranesi offers five types of linear fade:
� Depth graduates the effect between two different depths of the scene

To create a realistic fog effect, you would specify the fog at its thickest at the back of the scene, and at its thinnest at the front of
the scene.

� Ground graduates the effect between two different heights
To create a realistic ground fog effect, you would specify the fog at its thickest at the bottom of the scene, and at its thinnest
higher up in the scene.

� Any graduates the effect between any two parallel planes on the scene
For example, you could use this to portray reflected light on a surface.

� 2D graduates the effect between two screen positions; pixels are painted regardless of their depth
You could use this to create graduated backdrop, such as a sunset.

� Direction graduates the effect between two screen positions, based on the direction from the eye of the pixel, and the specified
direction
You could use this to create a graduated sky effect in a panorama EPix file.

Below shows an example of using Ground linear fade to create a realistic ground flog effect. The fade is thickest at the bottom of the
scene, and it fades to nothing just above the railings:

The next example shows a panorama scene before the fade effect is applied. The second illustration shows how Direction linear fade
is used to create the impression of a sunset. The effect was created in two stages, using Material lock and two paint colours.
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For details of linear fade characteristics, see Linear fade settings in Piranesi Help.
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To fade the effect radially from a point, click the Radial fade button on the Toolbox.

Piranesi offers two types of radial fade:
� 2D graduates the effect from a specified point in the plane of the scene

� 3D graduates the effect from a central point in all directions

Below shows an example of using 2D radial fade to create a soft, circular border around a building. The fade was centred on the
building and the range was set at the building perimeter; these positions were then inverted to create the effect:

For details of radial fade characteristics, see Radial fade settings in Piranesi Help.
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To create lighting effects, click the Illumination fade button on the Toolbox. When you paint the scene using illumination fade:

� planes orthogonal to the illumination are painted with full effect

� planes at 45° to the illumination are painted with half effect

� planes parallel to the illumination are not painted

Piranesi offers two types of illumination fade:

� Parallel creates the effect of parallel light
The direction of projection is orthogonal to the selected plane.

� Point creates the impression of a point light source
The light source emits light from a point equally in all directions, fading out at the given range.

Below shows an example of using Parallel illumination fade to create the effect of evening sunlight. The plane of the brick wall
defined the direction of the light, and the scene was filled with orange dodge blend:

Blend types are described on page 32.

For details of illumination fade characteristics, see Illumination fade settings in Piranesi Help.
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Apple, Macintosh, Finder, and Mac OS, are trademarks of Apple Computer, Inc., registered in the United States and other countries.

PowerPC is a trademark of International Business Machines Corporation.

LZW Compression is licensed under U.S. Patent No. 4,558,302 and foreign counterparts.

Other product names mentioned in this guide may be trademarks, and they are used for identification purposes only.
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Piranesi is from an original concept by Simon Schofield and Paul Richens, at the Martin Centre for Architectural and Urban Studies,
Cambridge University, UK.

Miller Hare Limited provided some sample images and tutorial resources.

Marlin Studios (http://www.marlinstudios.com) provided the hemispherical raster file used in the tutorial.
Copyright � 2001 Marlin Studios.

The following acknowledgement is for LZW compression in file importing and exporting within Piranesi.

LZW compression

Copyright � 1985, 1986 The Regents of the University of California. All rights reserved.

This code is derived from software contributed to Berkeley by James A. Woods, derived from original work by Spencer Thomas and
Joseph Orost.

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and
use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be
used to endorse or promote products derived from this software without specific prior written permission.

THE SOFTWARE IS PROVIDED ‘AS–IS’ AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE.


